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 Safety Guidelines 
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning and 
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes 
in this documentation qualified persons are defined as persons who are authorized to commission, ground and 
label devices, systems and circuits in accordance with established safety practices and standards. 

Prescribed Usage 
Note the following: 

WARNING  
This device may only be used for the applications described in the catalog or the technical description and only 
in connection with devices or components from other manufacturers which have been approved or 
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, 
positioning and assembly as well as careful operation and maintenance. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Definitions and warnings 1
1.1 Qualified personnel 

Description 
Qualified personnel in the context of the documentation are personnel who are familiar with 
the assembly, installation, commissioning, operation and maintenance of the SIMODRIVE 
611U product and who have the following qualifications: 
● Trained and authorized to energize, de-energize, clear, ground and tag circuits and 

equipment in accordance with established safety procedures. 
● Trained in the proper care and use of protective equipment in accordance with 

established safety procedures. 
● First aid training. 
Warnings are not explicitly given in this documentation. However, you are strongly advised to 
note the warnings contained in the operating instructions for each product from the 
SIMODRIVE series. 
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1.2 Description 

Contents 
This document describes the most important standard application options for the 
SIMODRIVE 611U used on the technology CPU. Although additional functions can be 
executed with the SIMODRIVE 611U, these must be examined on an individual basis. 
This description does not replace the device documentation for the SIMODRIVE 611U. A 
complete functional description of the SIMODRIVE 611U can be found in the Description of 
Functions for SIMODRIVE 611 Universal "Closed-Loop Control Components for Closed-
Loop Speed Control and Positioning". 

POSMO C and POSMO S 
POSMO C and POSMO S drives can also be used on the technology CPU.  
These drives belong to the SIMODRIVE 611U family and are parameterized with the same 
commissioning tools. The adaptation to the technology CPU is comparable to the approach 
described for the SIMODRIVE 611U. However, the functional scope is different and is 
contained in the corresponding device description.  
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Hardware Requirements 2
2.1 Converter 

611U converter 
● SIMODRIVE 611U closed-loop control module 
● Optional PROFIBUS DP3 module for isochronous PROFIBUS 

 
Closed-loop control module options: 
2axis for sin/cos 1 Vpp speed setpoint 

encoder  
6SN1118-0NH0x-0AAx 

2axis for sin/cos 1 Vpp positioning 
encoder  

6SN1118-1NH0x-0AAx 

2axis for n-set resolver  6SN1118-0NK0x-0AAx 
2axis for resolver positioning 6SN1118-1NK0x-0AAx 
1axis for n-set resolver  6SN1118-0NJ0x-0AAx 
1axis for resolver positioning 6SN1118-1NJ0x-0AAx 
Optional module PROFIBUS DP3 6SN1114-0NB01-0AA0 

 
 

 Note 
As a general principle, a closed-loop control card for speed setpoint operation is sufficient for 
operation with the technology CPU. This is also the case when DSC is used. 
If you want to use an external encoder on the axis, you must select a 2-axis closed-loop 
control module, whereby the second axis cannot be used to control a motor.  

 

POSMO SI 
SIMODRIVE POSMO SI is a complete 1-axis function unit. It consists of the following:  
● Power section 
● Control electronics 
● Motor 
Order number: 6SN2 4xx-2BF00-0Gxx 
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POSMO CD/CA 
SIMODRIVE POSMO CD/CA is a complete 1-axis function unit. It consists of the following:  
● Power section 
● Control electronics 
Order numbers: 
POSMO CD: 6SN2 703-2AAxx-0xA0 
POSMO CA: 6SN2 703-3AAxx-0BA0 
 

 

 Note 
The following sections refer only to the SIMODRIVE 611U. The described approach also 
applies to POSMO S and POSMO C. 
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Software Requirements 3
3.1 Converter 

3.1.1 Software upgrade 
 

 Note 
The SimoCom U must not be connected using PROFIBUS DP when the software upgrade is 
performed!  

 

Procedure 
1. Connect SimoCom U to the drive via the V24 interface. 

 
 

2. Open the firmware download window. 
If you want to upgrade the drive yourself, select the menu command Options > Service > 
Firmware upgrade. If you want to upgrade the PROFIBUS module, select the menu 
command Options > Service > Firmware upgrade of PROFIBUS option module.  
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You will be guided through the upgrade. Confirm the prompts and notes in the following 
windows.  

 

  Note 
This example shows the procedure for upgrading the firmware of the drive.  

 
 

3. Confirm the following information message: 
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4. Select the file with the desired firmware, e. g. the "611u.ufw" file and confirm your input 
with Open. 

 
 

5. Wait until the firmware has been fully loaded. 
 

  Note 
Do not cancel the downloading operation or interrupt the online connection to the 
SIMODRIVE 611U under any circumstances. 

 
 

6. Confirm the prompt with Yes. The drive executes a RESET. 

 
 

Result 
The firmware upgrade for the drive is completed. If required, you can now perform the 
firmware upgrade for the PROFIBUS module. 
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Commissioning 4
4.1 Introduction 

Overview 
This section describes the standard commissioning procedure using a sample configuration. 
The settings required in the technology CPU and in the SIMODRIVE 611U are explained. 
The sample configuration is based on the control of two position-controlled axes with DSC. 
Control is via PROFIBUS message frame 105, and a SIMODRIVE 611U double-axis module 
is used as drive. 
If you use another axis or message frame type or another SIMODRIVE 611U closed-loop 
control module, the structure of the input windows may differ from those described below. 
However, the principle approach remains the same. 
Moreover, you can use additional functions of the SIMODRIVE 611U in the user program (for 
example, reading of operating modes, etc.). Information on this can be found in the "Expert 
functions" section. 

 

 Note 
These instructions ensure only the connection of the SIMODRIVE 611U converter to the 
technology CPU. The guide does not describe how to optimize the controller; it is assumed 
that this has already been carried out. 

 

4.2 Commissioning procedure 

Operational sequence 
The commissioning procedure is divided into two parts: 
In the first part, a STEP 7 project is created and the S7T Config program and the hardware 
manager are used to enter the settings of the technology CPU for the attached hardware. 
The settings that have to be made both in the technology CPU and in the SIMODRIVE 611U 
are given special attention.  
In the second part, the SIMODRIVE 611U is parameterized. The basic device 
commissioning for connection to the technology CPU is used for this.  
Various parameter settings for the SIMODRIVE 611U are derived from the technology CPU 
settings. The table contains in Section 1.2 an overview of the functions and settings which 
have to be entered in both the technology CPU and the SIMODRIVE 611U. The settings that 
have been made can be entered in the table. These settings are explained in detail in the 
following sections for both the technology CPU and the SIMODRIVE 611U. 
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4.3 Table of the settings 

Settings for the commissioning 
You require this data for the following commissioning steps. You can prepare the values 
using this table. 

 
DP cycle ________ ms  

❑ Incremental encoder Specify encoder 
❑ Absolute encoder 
❑ Homing cam + encoder zero mark 
❑ Only encoder zero mark 
❑ Only homing cam 
❑ 1. Zero position at the right of the homing 
cam 

Homing mode  

❑ 1. Zero position at the left of the homing 
cam 

"Measuring" function ❑ 
Encoder type (order number) 1Fxxxxx- _ xxxx-x _ xx 
Motor rated speed/max. speed axis ______ rpm 
Master application cycle/position control 
cycle clock 

______ 

Message frame (see decision table) ______ 
PROFIBUS address ______ 

Message frame decision table 
By default, the SIMODRIVE 611U is connected to the technology CPU via PROFIBUS DP. 
Depending on the desired axis functionality, this connection can be made using various 
device-specific message frames. The following selection table shows the options for the 
individual message frame types: 

 
 Sign-of-life 

monitoring 
(SoLmon) 

1. 
Encoders 

__________ 
Measuring 

2.  
Encoders 

Dynamic servo 
control (DSC) 

Torque 
reduction 

(Mred) 

Required 
message frame

     1 
x     2 

Speed-
controlled axis 

x    x 101 
x x    3 
x x x   4 
x x  x  5 
x x x x  6 
x x   x 102 
x x x  x 103 
x x  x x 105 

Position 
axis/following 

axis 

x x x x x 106 
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 Note 
The message frame types < 100 are standard message frames. These are standardized via 
the PROFIdrive profile. The message frame types > 100 are device-specific message frame 
types for the SIMODRIVE 611U. 

 

4.4 Setting up a STEP 7 project 

4.4.1 Performing the hardware configuration 

Introduction 
In this step, the technology CPU (in this example, the CPU 317T 2 DP), the bus system and 
the connected devices, here the SIMODRIVE 611 universal, are configured in STEP 7 using 
the hardware configuration  program and S7T Config. 

Procedure 
● After starting the SIMATIC manager, you must first create a new project (e.g. with the 

name DSC_SIMODRIVE): 

 
Figure 4-1 Creating a project 
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● A new S7 300 station is created in the Insert > Station > SIMATIC 300 Station menu. 

 
Figure 4-2 Inserting a SIMATIC station 300 

● A double-click on the Hardware element in the SIMATIC 300 station opens the hardware 
configuration: 

 
Figure 4-3 Open the hardware configuration 

The HW Config application starts and opens the empty SIMATIC 300 station. Now select 
the mounting channels from the SIMATIC Technology CPU hardware catalog and add 
them to the configuration using drag-and-drop. Add the CPU 317T-2 DP at slot 2 of the 
mounting channels. 
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● Read carefully the information for downloading the system data and then click OK to 
confirm. 

 
Figure 4-4 Information for downloading the system data 

The Properties - PROFIBUS Interface DP(DRIVE) (R0/S3.1) window is displayed. 

 
Figure 4-5 PROFIBUS interface DP(DRIVE) properties 
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● Click the New button in the Properties - PROFIBUS Interface DP(DRIVE) (S0/S3.1) 
window to assign a network to the DP drive interface. The PROFIBUS configuration is set 
in the displayed dialog. Select the Network Settings tab for this purpose. 
– Set "2" as the largest PROFIBUS address 
– Set a transmission rate of 12 Mbit/s on the bus and DP as profile. 

 
Figure 4-6 PROFIBUS subnet properties 

● Click the Options button and activate the Activate equidistant bus cycle checkbox in the 
Constant Bus Cycle Time tab. 

 
Figure 4-7 Activate isochronous bus cycle 
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● Enter the desired cycle time, e.g. 3 ms in the isochronous DP cycle field. The other 
described settings are all shown for a DP cycle of 3 ms. 

● Click on OK to confirm your settings. The configured objects are then added to the 
SIMATIC 300 station. 

 
Figure 4-8 SIMATIC 300 Station 

 

  Note 
The X1-MPI/DP interface in the rack is not networked for this example. It is set by default 
for MPI communication at 187.5 Kbaud. To load the technology system data to the 
module, the transmission speed of the interface should be set to ≥ 1.5 Mbaud.  
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● Configure on the PROFIBUS a SIMODRIVE 611 universal (e.g. with address 3) that is 
contained in the hardware catalog at CPU 317T\PROFIBUS 
DP(DRIVE)\Drives\SIMODRIVE. 

 
Figure 4-9 Adding a SIMODRIVE 611 universal to the PROFIBUS 
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Set the PROFIBUS address of the SIMODRIVE 611U 
The PROFIBUS address must be set in the SIMODRIVE 611U in the P918 parameter. With 
SimoCom U, the entry can be made in the PROFIBUS Parameterization window. 
● Click OK to confirm the Properties - Drive window. 
● In the Configuration tab of the DP Slave Properties window, select the required 

PROFIBUS message frame for the connection. In this example, a 611U double-axis 
module connected via message frame 105 is selected. The subsequent axis motion will 
be position-controlled. 

 
Figure 4-10 Set message frame 105 on the slave 

The required message frame can be selected using the "message frame type decision 
table". 
Technology CPU 
The message frame selected here is specified again when the axis is subsequently created. 
The setting is automatically taken over from the hardware configuration when the axis is 
created. 
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SIMODRIVE 611U 
The message frame selected here must be set in the P922 parameter in the SIMODRIVE 
611U. With SimoCom U, the entry can be made in the PROFIBUS Parameterization window. 
● Make the following settings in the Clock-synchronized operation tab: 

 
Figure 4-11 Activate clock-synchronized operation 
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● Select Synchronize drive with equidistant DP cycle. 
– DP cycle: 

Bus clock cycle: depends on the number of slaves (minimum 1.5 ms) 
– Master application cycle: 

Here, you specify the cycle clock in which the master is to supply new values to the 
SIMODRIVE 611U. For the CPU 317T-2 DP, this is the position control cycle clock 
(servo). You must note this value and enter it later when configuring the system clocks 
as position control cycle clock.  

 

  Note 
It is mandatory that the master application cycle match the position control cycle clock 
of the CPU! 

– Setpoint acceptance: 
Setpoint is output in the SIMODRIVE 611U as soon as possible after the DP clock 
cycle. The time depends on the number of isochronous slaves. It must be ensured that 
the last slave has also received the setpoint values in the current DP cycle. Otherwise, 
the drive signals it is "not isochronous with the master". 

– Actual-value acquisition 
Measured value is latched in the SIMODRIVE 611U as soon as possible before the 
DP cycle clock (Input 1: → 0.125 ms before the next DP cycle clock). 

● Perform match. Clicking the button causes the following settings to be made:· 
– The equidistant bus cycle will be activated· 
– The DP cycle in the master system will be matched to the drive properties and set to 

2000 ms 
– All drive components of the same family receive the same parameterization 

● You must then save and compile the project (Station > Save and compile). The 
consistency must also be tested (Station > Test consistency). 
Once these steps have been performed without error, you must load the hardware 
configuration into the CPU 317T-2 DP (Target system > Load into the module). 
If you have changed the transmission speed of the MPI/DP interface, you must modify 
the interface parameters in the PG/PC interface in order to subsequently load to the 
technology system data to the module. 
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The hardware configuration thus does not contain any technology system data. The 
creation of this data will be activated separately in the hardware configuration. To do this, 
double-click Index 3 (Technology) in the mounting channels of the SIMATIC 300 station 
and switch to the "Technology system data" tab. Activate Generate technology system 
data, save and compile the configuration, and reload it into the CPU. 

 
Figure 4-12 Activate generate technology system data  

 

  Note 
It is also possible to download the technology system data with the hardware 
configuration in a single step in order to avoid the need for the second download. The 
described procedure has the advantage that the download of the technology system data 
uses the higher transmission speed of the communication connection and thus takes less 
time. 
If the load process has completed successfully, only the green and the yellow LEDs 
illuminate. The red BF 3 LED (the mode selector switch is at the STOP position). The bus 
error occurs if the PROFIBUS address configured in HW Config or the selected message 
frame type have not yet been set in the SIMODRIVE 611U.  
If communication between the two devices is to be checked at this point, then the basic 
functions of the SIMODRIVE 611U must have been commissioned as specified in the 
"Create STEP 7 Project" section. 
If the settings in the CPU 317T-2 DP and the SIMODRIVE 611U match, the BF 3 error 
does not occur and the LED on the PROFIBUS module of the SIMODRIVE 611U is 
green.  

Result 
This completes the hardware configuration of the station and the window can be closed. 
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4.4.2 Create axis 

Introduction 
This step describes the procedure for creating an axis in S7T Config. Because the 
SIMODRIVE 611U double-axis module is used in the hardware configuration, two axes must 
be created and the procedure described here performed twice. 

 

 Note 
Using a double-axis module 
If a double-axis module is used, either both axes must be set up as TO, or both axes must 
be addressed by the user program via the PZD interface. Mixed operation is not possible.  
To deactivate: Both TOs of a double-axis module must be deactivated at the same time. It is 
not possible to deactivate just the TO of one of the axes.  

 

Procedure 
● A double-click on the Technology objects entry in the Technology folder in the created 

SIMATIC 300 station starts the Technology Object Management application in the 
SIMATIC Manager. 

 
Figure 4-13 Technology objects in the SIMATIC Manager 

The Technology Object Management application opens. If no technology objects have 
been configured, then S7T Config is automatically started. Otherwise start S7T Config by 
selecting the Options > Configure technologymenu command in the Technology Object 
Management.  
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  Note 
Alternatively, you can also run S7T Config without starting the Technology Objects 
Management. To do this, select the object Technology objects in the folder Technology of 
theTechnology CPU and start the S7T Config using the menu command Tools > 
Configure technology. This procedure is particularly useful when no new technology 
objects are to be created and consequently no technology data blocks need to be 
created. 

● In S7T Config, open the Axes folder: 

 
Figure 4-14 Inserting an axis 

● The following window opens after double clicking on Insert axis : 

 
Figure 4-15 1st window of the axis configuration 
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● Click OK to open the Axis configuration - Axis type window. Specify the axis type here. In 
the example, the linear axis setting is retained: 

 
Figure 4-16 2nd window of the axis configuration 
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● Click Next to open the Axis configuration - Units window. The physical quantities are 
specified there. Do not change anything and click on Continue. 

 
Figure 4-17 3rd window of the axis configuration 
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● The window for configuring the modulo axes opens. If necessary, activate the modulo 
axis and click on Continue. 

 
Figure 4-18 4th window of the axis configuration 
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● The hardware configuration will then be loaded automatically and you can select in the 
Drive window the SIMODRIVE 611U drive A or B parameterized in HW Config. The 
message frame 105 that you specified previously in HW Config is set as default message 
frame. The maximum motor speed in this example is 6000 RPM. Select the function 
Dynamic drive control (DSC): 

 
Figure 4-19 5th window of the axis configuration 

Specifying the maximum motor speed 
The motor speed is set in the Technology CPU and in SIMODRIVE (rated speed). This value 
is used to determine the maximum speed (→ maximum possible speed) at the axis and the 
scaling of the PROFIBUS speed value in the SIMODRIVE 611U. 

Technology CPU 
The maximum motor speed normally corresponds to the rated speed of the motor used. All 
specified speeds of the axis are based on this maximum speed. 
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SIMODRIVE 611U 
This speed must be specified in the P880 parameter.  
This specifies the scaling of the PROFIBUS speed value. For the maximum speed, a 
setpoint NSET = 4000 0000 hex is transferred to the drive via the PROFIBUS. The P880 
parameter is used to inform the SIMODRIVE 611U which speed should be set when NSET = 
4000 0000 hex. 
● The encoder is configured in the next windows. 
The absolute value encoder must be configured as ENDAT encoder, e.g. EQN 1325 as 
ENDAT (refer to the following two figures). 

 
Figure 4-20 Axis configuration in S7T Config (selects the encoder type for absolute encoders) 
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Figure 4-21 Axis configuration in S7T Config (enters the resolution of the absolute encoder) 
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Incremental encoders will be set appropriately (square TTL, sine, resolver) and the 
resolution entered using the manufacturer's data (refer to the following two figures). 

 
Figure 4-22 Axis configuration in S7T Config (selects the encoder type for incremental encoders) 
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Figure 4-23 Axis configuration in S7T Config (enters the resolution of incremental encoders) 

Specifying the encoder and the resolution 
The encoder and the resolution are specified in the Technology CPU and in the 
SIMODRIVE 611U.  

SIMODRIVE 611U 
The encoder used for the drive configuration is selected using the order number (motor 
rating plate). 
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Technology CPU 
The data of the encoder used that is necessary to make the settings for the Technology CPU 
is shown in the following section. Only the listed input values are evaluated for the respective 
encoder. 
The following settings refer to the input value for the fine resolution 0. 
If a fine resolution 0 (standard) is set in the Technology CPU, this means a fine resolution of 
211 = 2048. If a different value is set (e.g. 1024), this means the actual fine resolution. 
Encoder parameters in SIMOTION are specified using parameters in the axis configuration 
windows or using the configuration data in the expert list as 
"TypeOfAxis.NumberOfEncoders.Encoder_1.xxx". The following assignments apply to the 
axis configuration windows:  

 
Parameter Meaning 
Encoder type TypeOfAxis.NumberOfEncoders.Encoder_1.encoderType 
Encoder mode TypeOfAxis.NumberOfEncoders.Encoder_1.encoderMode 
Resolution TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolution 

TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolution 
Number of data bits TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsDataLength 
Multiplication factor of 
the cyclic encoder 
actual value 

TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolutionMultiplierCyclic 
TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.AbsResolutionMultiplierCyclic 

Multiplication factor of 
the absolute encoder 
actual value 

TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolutionMultiplierAbsolute 

 

Encoder settings 
 
Encoder type Vendor SIMODRIVE 611U-relevant settings 
Endat motor 
encoder 

Endat 2048 pulses/rev 1Fxxxxx-xxxxx-
xExx 
Encoder system for motors with DRIVE-
CLiQ interface: 1Fxxxxx-xxxxx-xFxx 

611U parameters:  
Encoder lines (1005): 2048 
Encoder fine resolution (1042):=11  
Encoder fine resolution absolute (1043):=9  
SIMOTION:  
Encodersystem:=rotatory_system 
Encodertype:=sensor_absolute_cyclic 
encoderMode=ENDAT  
AbsEncoder. Absresolution:=2048  
Absdatalength:=23  
AbsResolutionMultipliercyclic:=2048 (0) 
AbsResolutionMultiplierabsolute:= 512 (0) 
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Encoder type Vendor SIMODRIVE 611U-relevant settings 
Endat motor 
encoder 

Endat 512 pulses/rev 1Fxxxxx-xxxxx-xHxx
Encoder system for motors with DRIVE-
CLiQ interface: 1Fxxxxx-xxxxx-xLxx 

611U parameters:  
Encoder lines (1005): 512  
Encoder fine resolution (1042):=11  
Encoder fine resolution absolute (1043):=9 
SIMOTION: 
Encodersystem:=rotatory_system 
Encodertype:=sensor_absolute_cyclic 
encoderMode=ENDAT 
AbsEncoder. Absresolution:=512 
Absdatalength:=21 
AbsResolutionMultipliercyclic:=2048 (0) 
AbsResolutionMultiplierabsolute:= 512 (0) 

Endat motor 
encoder 

Endat 32 pulses/rev 1Fxxxxx-xxxxx-xGxx 611U parameters: 
Encoder lines (1005): 32  
Encoder fine resolution (1042):=11  
Encoder fine resolution absolute (1043):=9  
SIMOTION: 
Encodersystem:=rotatory_system 
Encodertype:=sensor_absolute_cyclic 
encoderMode=ENDAT 
AbsEncoder. Absresolution:=32 
Absdatalength:=17 
AbsResolutionMultipliercyclic:=2048 (0) 
AbsResolutionMultiplierabsolute:= 512 (0) 

Incremental 
sin/cos motor 
encoder 

optical incremental encoder sin/cos 1 Vpp 
2048 pulses/rev ERN1381 / 1387 
1Fxxxxx-xxxxx-xAxx  
Encoder system for motors with DRIVE-
CLiQ interface: 1Fxxxxx-xxxxx-xDxx 

611U parameters: 
Encoder lines (1005): 2048  
Encoder fine resolution (1042):=11  
Encoder fine resolution absolute (1043):=9 
SIMOTION: 
Encodersystem:=rotatory_system 
Encodertype:= sensor_incremental 
encoderMode=sinus_vpp IncEncoder.IncResolution:=2048 
IncResolutionMultipliercyclic:= 2048(0) 
For incremental encoders, a fine resolution of 0 (default 
value) in the IncResolutionMultipliercyclic parameter 
means a fine resolution of 211 = 2048 
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Encoder type Vendor SIMODRIVE 611U-relevant settings 
Resolver 2-pin: 1Fxxxxx-xxxxx-xTxx  

Multi-pin: 1Fxxxxx-4xxxx-xSxx  
Encoder system for motors with DRIVE-
CLiQ interface:  
2-pin: 1Fxxxxx-xxxxx-xPxx  
Multi-pin: 1Fxxxxx-4xxxx-xUxx 

611U parameters: 
Resolver pole pair count:=1,2,3 or 4  
SIMOTION: 
Encodersystem:=rotatory_system 
Encodertype:= sensor_incremental 
encoderMode= RESOLVER 
IncEncoder.Incresolution:= *) 
IncResolutionMultipliercyclic:= 2048(0) 
*) Depending on the value of 611U parameter P1011.2, the 
following setting applies  
P1011.2=0:  
IncResolution :=1024 (2-pole)  
 =2048 (4-pole)  
 =3072 (6-pole)  
 =4096 (8-pole)  
P1011.2=1:  
IncResolution :=4096 (2-pole)  
 =8192 (4-pole)  
 =12288 (6-pole)  
 =16384 (8-pole)  
For incremental encoders, a fine resolution of 0 (default 
value) in the IncResolutionMultipliercyclic parameter 
means a fine resolution of 211 = 2048 

 
Note: 
For the encoders, a fine resolution of 0 (default value) 
● in the 

TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolutionMultiplierCyclic 
parameter, a fine resolution of 211 = 2048 

● in the 
TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolutionMultiplierAbsolute 
parameter, a fine resolution of 29 = 512 
Differences between ABS and CYCLE_ABS: 
– In the case of ABS, the absolute actual position of the encoder is assumed after 

powering up the Technology CPU or following an encoder error. 
– In the case of CYCL_ABS, overflows of the encoder ranges are tracked in the NVRAM 

and taken into account when the cycle is resumed. 
The encoder must be calibrated after the initial loading.  
If the settings for the absolute encoder are modified, the encoder must also be re-
adjusted.  
With the CPU switched off, the encoder may only be moved a maximum distance ≤ 
"half the encoder range" in both traversing directions in order to still be able to detect 
the exact position. 
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Completing the axis configuration 
● Finally click on Complete. The set data will be summarized: 

 
Figure 4-24 Last window of the axis configuration 

After the axis is created, a few more settings have to be made to optimize the interaction 
between Technology CPU and SIMODRIVE 611U. 
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Following error monitoring 
To prevent the following error monitoring interrupting an axis motion, it can be set to a higher 
value or deactivated. A high following error can occur, for example, as a result of a missing 
drive optimization. 
This causes the Monitoring window of the created axis to be called and the Dynamic 
following error monitoring active setting deselected in the Following error monitoring tab 
(refer to the following figure). 
The following error monitoring should, of course, be matched to the requirements and 
mechanical system of the plant when commissioning an application. 

 

WARNING  
If the following error monitoring is increased or deactivated, larger incorrect motions can 
also occur on the axis in the case of an error (e.g. incorrect position control direction). This 
is particularly important, for example, when the axis only has a limited traversing range. 

 

 
Figure 4-25 Deactivate following error monitoring  
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Position controller configuration 
In S7T Config, select the control of Axis_1. 
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The window of the Position controller is opened and the Kv factor, the speed pre-control and 
the velocity-dependent interpolation are set. The Dynamic drive control (DSC) function 
remains selected: 

 
Figure 4-26 Position controller configuration 
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Setting the system clock cycles 
Right-click Technology and select the Set system clock cycles entry in the context menu. 
The following window opens: 

 
Figure 4-27 Set system clock cycles 

Specifying the system clock cycles 
The specifications for system clock cycles in the Technology CPU affect the position setpoint 
adjustment in the SIMODRIVE 611U. 

Technology CPU 
The ratio of DP clock cycle to position controller clock cycle and to interpolator clock cycle 
(refer to the "Set system clock cycles" figure) is set to 1:1:3, for example. This represents a 
DP clock cycle of 3 ms, a position controller clock cycle of 3 ms and an interpolator clock 
cycle of 9 ms. 

 

 Note 
The position controller clock cycle entered here must match the master application cycle in 
the HW Config! 

 
For instructions on how to activate and use interpolator clock cycle 2, see the online 
documentation in S7T Config. 
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Task monitoring time 
The task monitoring time monitors the processing of the Motion Control jobs. 

Technology DB update 
The setting for the time of the technology DB update determines the time intervals in which 
the technology DBs in the S7 will be updated. 

Maximum task processing 
The time monitoring for the processing of jobs for the RUN/STOP transition of the CPU. 

Number of the tolerated IPO and IPO2 overflows 
An "IPO overflow" will occur if the processing of the interpolator (IPO or IPO2) lasts longer 
than the configured interpolator clock cycle. In this case the following interpolator cannot be 
started in the selected cycle and will be omitted. If the processing of the interpolator is 
completed at the next cycle, it will be started as usual. 
Each omitted interpolator will be counted as "IPO overflow". Set in the selection list how 
many successive "IPO overflows" are tolerated before the Technology CPU switches to the 
STOP operation mode. 
The S7T Config project is now configured. Provided the axis does not need to be homed and 
you do not use the Measurement function on the axis, you can continue with the 
configuration of the SIMODRIVE 611U. 
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4.4.3 Referencing 

Specification of the homing mode 
If the connected axis is to be homed, the homing mode must be specified in the technology 
CPU. Depending on the mode selected, settings may also be necessary in the SIMODRIVE 
611U. 

Homing mode "External zero mark only" 
Operational sequence: 
● When a defined edge of the zero mark is crossed, the position is accepted. 
Hardware structure: 

 
Figure 4-28 Homing (External zero mark only) 
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Technology CPU 
If External zero mark only is selected as the homing mode (see figure below), the approach 
direction can be selected by means of Start homing. 

 
Figure 4-29 Axis homing in STEP 7 (homing mode only external zero mark) 
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SIMODRIVE 611U 
The homing cam on the SIMODRIVE 611U must be placed at the I0.x input (x: drive A or B). 
Parameterize the I0.x input with the Equivalent zero mark function. You must enable the 
equivalent zero mark via parameter P879 Bit 13. 
Follow the procedure outlined in the section below on "Standard commissioning of 
SIMODRIVE 611U" for the parameterization of input I0.x.  
Comment for the 611U edge detection: 
● For travel in the positive direction, only the signal change 1 → 0 is recognized as 

equivalent zero mark. For travel in the negative direction, only the 0 → 1 edge is 
recognized as equivalent zero mark. As a result, not all of the approach directions that 
can be selected in the technology CPU in combination with SIMODRIVE 611U can be 
used. 

Homing mode "Encoder zero mark only" 

Operational sequence 
A homing cam signal is not necessary. The position is accepted at the next zero mark of the 
encoder. 
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Technology CPUs 
If Encoder zero mark only is selected as the homing mode (see following figure), the 
approach direction can be selected by means of Start homing. 

 
Figure 4-30 Axis homing in STEP 7 (homing mode only encoder zero mark) 

SIMODRIVE 611U 
If zero mark only is selected as the homing mode, a motor with an incremental encoder or 
resolver must be connected on the SIMODRIVE 611U. Otherwise, no additional settings are 
necessary. 
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Homing mode "Homing output cam and encoder zero mark" 

Operational sequence 
The axis traverses in the specified homing direction. Once the homing cam signal is 
reached, the velocity of the axis switches from the homing approach velocity to the homing 
reduced velocity. Once the homing cam is left, the axis is homed at the next detected zero 
mark of the encoder. 

Hardware configuration 
The homing cam is connected to a free SIMATIC peripheral input (either on the integrated 
input of the technology CPU or on the remote input on the DP(DRIVE)). 

 
Figure 4-31 Homing (Homing output cam and encoder zero mark) 
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Technology CPU 
If "Homing output cam and encoder zero mark" is selected as the homing mode (refer to the 
following two figures), the evaluation position of the zero mark can be selected via zero mark 
and the approach direction via Start homing. 
The homing cam must be applied at a freely selected digital input of the SIMATIC that was 
configured in the Axis homing window (refer to the following two figures). When this homing 
cam is reached, homing is enabled in the drive. 

 
Figure 4-32 Axis homing in STEP 7 (homing cam homing mode and encoder zero mark) 
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Figure 4-33 Axis homing in STEP 7 (homing cam homing mode and encoder zero mark) 

SIMODRIVE 611U 
With this mode, a motor with an incremental encoder or resolver must be connected on the 
SIMODRIVE 611U. Otherwise, no additional settings are necessary. 



 Commissioning 
 4.4 Setting up a STEP 7 project 

Connecting the SIMODRIVE 611U to the Technology CPU 
Product Information, 03/2008, A5E00272066-05 51 

4.4.4 "Measuring" function 

Description 
You can use the "measuring" function to acquire the actual position of an axis at any time. A 
typical application is the acquisition of a print mark for the purpose of synchronizing the axis 
to this mark. 

Hardware configuration 
The measuring input must be connected to the fast input I0.x. The input is isolated. This 
enables more than one input to be switched in parallel, whereby the reference potential of 
the 24 V supply of the measuring input (for example, from the network supply) must also be 
wired. 

 
Figure 4-34 Measuring 
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Technology CPU 
Add a measuring input in the "Measuring input" folder below the axis.  
→ Inserting a measuring input 
Leave the measuring input number and the system number at the value 1. This is no way to 
assign several measuring inputs on the drive (max. number per 611U axis = 1). 

 
Figure 4-35 Inserting a measuring input 
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Figure 4-36 Inserting a measuring input 



Commissioning  
4.4 Setting up a STEP 7 project 

 Connecting the SIMODRIVE 611U to the Technology CPU 
54 Product Information, 03/2008, A5E00272066-05 

 
Figure 4-37 Measuring Input Configuration 

SIMODRIVE 611U 
Parameterize the SIMODRIVE 611U with SimoCom U so that input I0.x addresses the 
measuring input. 
Use the MC_MeasuringInput technology function in the user program to make the edge 
selection: 
● positive edge 
● falling edge 
If you select another setting, the last valid value is taken over (rising or falling). 
Comment on 611U-internal edge detection in HW versions up to 6SN1118-xxxxx--xxx1: 
● For travel in the positive direction, only the 1 → 0 signal change is detected as a 

measuring signal. For travel in the negative direction, only the 0 → 1 edge is recognized 
as measuring signal. You must take this into account when activating the measuring 
input. 
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Response times for the measuring function 
The technology CPU can be used for measuring with different configurations. Depending on 
the connection of the axis (using PROFIBUS DP) and the processing level (position control 
cycle clock or interpolator cycle clock), you must allow for different response times for the 
Measurement function in the application. 
The measurement in the user program is controlled by calling the MC_MeasuringInput 
function block. You can specify when the measuring function is to be active during the call: 
● immediately (without measuring window / triggering range) 

StartPosition = EndPosition 
● within a position-dependent measuring window 

StartPosition < > EndPosition 
For the Measurement without measuring window, MC_MeasuringInput immediately activates 
the measuring input. 
A configuration-dependent delay elapses before the measuring edge is evaluated at the 
hardware input (refer to the "Measurement without measuring window" table). To be certain 
to detect the measuring edge, you must ensure that MC_MeasuringInput is executed earlier 
by this amount of runtime in the user program. 
When measuring with measuring window, the job is first only registered in the system with 
MC_MeasuringInput. The measuring input is activated only when the axis has reached the 
start of the measuring window. 
A configuration-dependent delay elapses after reaching the start position of the measuring 
window on the axis (mechanical construction) before the measuring edge is evaluated at the 
hardware input (refer to the "Measurement with measuring window": Measuring edge is 
detected in the window" table). To ensure that the measuring input is active when the 
required start position of the measuring window is reached, you must move forward the start 
of the measuring window depending on the axis speed and the response time when the 
function is called. 
The same applies to the end of the measuring window. It is important that the measuring 
input is no longer active when the end of the measuring window on the axis (mechanical) is 
crossed (for the run times, see "Measuring with measuring window: no measuring edge in 
the window" table). 
These run times can be compensated using the MeasuringRange.activationTime 
configuration data ("Measuring input configuration", "Activation time of the triggering range 
on the measuring input" figure). 

 

 Note 
The offset of the measuring window only functions reliably when the axis velocity 
• Within the measuring window is constant and 
• Known before the function call. 

 
You can determine the response times for your configuration using the following tables. The 
values in the tables refer to set system cycle clocks. By using the actual times, you can 
calculate the response time in milliseconds. 
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The following abbreviations are used in the tables: 
● (IS): Interpolator or position control cycle clock (can be selected for the configuration of 

the measuring input) 
● (DP): cycle time on the PROFIBUS DP 
● (DR) Cycle time in the drive (time slice in which the measuring function is evaluated) 

Table 4-1 Measuring without measuring window 

 SIMODRIVE 611U 
MC_MeasuringInput 
→ Ready to detect the measuring edge 

3 (IS) +7 (DP) 

Detection of the measuring edge 
→ Result in the technology CPU for further processing 

2 (IS) +10 (DP) 

Total 
Minimum time between two measurements *) 

5 (IS) +17 (DP) 

*): In addition, the restrictions of the system must be taken into account. 

Table 4-2 Measuring with measuring window: Measuring edge is detected in the window 

 SIMODRIVE 611U 
MC_MeasuringInput 
→ Ready for the evaluation of the measuring range (start of the measuring window) 

2 (IS) 

Start of the measuring window on the axis (mechanical) reached 
→ Ready to detect the measuring edge 

2 (IS) +7 (DP) 

Detection of the measuring edge 
→ Result in the technology CPU for further processing 

2 (IS) +10 (DP) 

Total 
Minimum time between two measurements *) 

5 (IS) +17 (DP) 

*): In addition, the restrictions of the system must be taken into account. 

Table 4-3 Measuring with measuring window: No measuring edge in the window 

 SIMODRIVE 611U 
MC_MeasuringInput 
→ Ready for the evaluation of the measuring range (start of the measuring window) 

2 (IS) 

Start of the measuring window on the axis (mechanical) reached 
→ Ready to detect the measuring edge 

2 (IS) +7 (DP) 

Start of the measuring window on the axis (mechanical) reached 
→ Reset: "Ready to detect the measuring edge" 

2 (IS) +7 (DP) 

Reset the measurement readiness 
→ Confirmation in the technology CPU for further processing 

2 (IS) +10 (DP) 

Total 
Minimum time between two measurements *) 

7 (IS) +24 (DP) 

*): In addition, the restrictions of the system must be taken into account. 
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Load the program into the technology CPU and switch to RUN 
Save and compile the technological settings. 
The mode selector switch of the technology CPU is still at the STOP position. 
Use Technology > Connect with the target system to establish the connection to the 
technology CPU. 
Use Technology > Load into the target system to load the project into the technology CPU. 
Once the project has been loaded into the target system, use the mode selector switch to 
switch the technology CPU to RUN. 

Creating the technology DBs (TO-DBs) 
Once the configuration with S7T Config has been completed, technology DBs must be 
produced for the created technology objects (e.g. axes, cams, output cams, measuring 
inputs). The "Technology Object Management" is used here. 
Switch to the "Technology Object Management" if it is not yet open. Otherwise, double-click 
on the Technology objects entry in the Technology folder of the SIMATIC station to start the 
"Technology Object Management". 

 
Figure 4-38 Start TOM from the SIMATIC Manager 
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The "Technology Object Management" starts with the following dialog. 

 
Figure 4-39 Technology Object Management 
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The lower window half of the dialog shows the technology objects that have been configured 
in S7T Config or are present as standard, but for which no TO DB exists. If necessary, 
change the data block numbers of the TO DBs and click Create to generate the DBs. 

 
Figure 4-40 Create TO DBs 

If TO DBs have been generated for the existing technology objects, they will be displayed in 
the upper window half of the "Technology Objects Management". The tool can now be 
closed.  
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The created TO DBs are now contained in the Modules folder of the SIMATIC 300 station. 
The icons for the DBs will be derived from the designations in the configuration, if 
necesssary, the UDTs will be extended. 

 
Figure 4-41 TO DBs in the SIMATIC Manager 
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4.5 Drive configuration for SIMODRIVE 611U 

Procedure 
The SimoCom U commissioning tool is used for commissioning the SIMODRIVE 611U. This 
SimoCom U commissioning tool is intuitive for the most part. You are guided through the 
individual steps.  
The connection to the drive can either be made via a serial interface or PROFIBUS DP.  
First, the drive configuration prompting is used to configure the hardware (associated power 
section, motors, encoders, etc.), the PROFIBUS interfaces, etc.  
● Once you have started SimoCom U, you will be prompted in the first window where you 

want to change the data for the drive. 
Establish a connection (serial, PROFIBUS DP) between SimoCom U and the drive and 
select "Find online drives...". This has the advantage that you do not need to enter the 
data for the closed-loop control card and the PROFIBUS module. This data is read out 
and displayed by SimoCom U. 

 

  Note 
To allow you to operate the SIMODRIVE 611U PROFIDrive-conform, the following 
parameters have been added or extended with the software version from 06.02.2003: 
• P1012.2 → must be set 
• P1012.12 → must be set 
• P1012.13 → must be set 
• P1012.14 → may not be set 
The help for P878 provides further information. 
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Figure 4-42 SimoCom U: Option boxes 

● In the basic window of the SimoCom U, call the Configuration > Reconfigure drive menu 
items to select the prompted drive configuration. 

 

  Note 
If you use a double axis module, you must perform the following procedure twice, for 
Drive A and Drive B. However, you must ensure that the PROFIBUS address setting is 
applicable to both drives. In addition, the same PROFIBUS message frame must be used 
for both drives. 

 
Figure 4-43 SimoCom U: Basic window 
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● You can enter in this window an arbitrary name for the axis: 

 
Figure 4-44 Drive configuration window 

● In the Select SIMODRIVE window, the order numbers of the controller module and the 
PROFIBUS module are displayed with a gray background, as you are connected online 
with the SIMODRIVE 611U. These input values cannot be changed. 
In this window, specify the PROFIBUS address. The address must agree with the bus 
address specified in the STEP 7 hardware configuration. 

 
Figure 4-45 SIMODRIVE selection 
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● Select the connected motor in the following Motor selection window. The data can be 
found on the name plate of the motor. 

 
Figure 4-46 Motor selection window 

● Select the connected motor encoder in the Measuring system/encoder window. The data 
can be found on the name plate of the motor. 
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Technology CPU 
You require this data to adjust the encoder when you commission the axis. Use this number 
to find the corresponding input values for the S7T Config DP axis configuration in the "List of 
encoder data". 

 
Figure 4-47 Measuring system/encoder window 
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● In the Operating Mode window, you must select the speed/torque setpoint. This option is 
only available for the 611U closed-loop control modules that are also capable of 
positioning operation. 

 
Figure 4-48 Operating mode 
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● You can select an external encoder in the Direct measuring system/encoder window. This 
encoder can only be measured on a double-axis module via the measuring input for Axis 
B. As a result, Axis B is no longer available for controlling an axis. 
If you use the direct measuring system, you must select a PROFIBUS message frame 
that contains a second encoder. In the technology CPU, you can assign this encoder for 
the position control or create an external encoder that accesses this actual value.  

 
Figure 4-49 Direct measuring system/encoder 
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● The Completion of drive configuration window displays a summary of the inputs. Finally, 
click the Calculate controller data, save, reset button to confirm. 

 
Figure 4-50 Completion of the drive configuration 

● Then select the PROFIBUS Parameterization window. Here you can select the 
PROFIBUS address of the drive, 3 in this example, and the message frame, 105 in this 
example. 
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Technology CPU 
Specify this data during the hardware configuration to adjust the drive. 

 
Figure 4-51 SimoCom U - Drive A 
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● Optional: Select the Digital inputs window. Here you can define the function of input I0.x. 
If you want to use the "measuring function" in the technology CPU, you must select the 
"Flying measurement/length measurement" function here. 
If you want to use the "Homing only homing cam" function in the technology CPU, you 
must select the "Equivalent zero mark" function here. In addition, you must enable the 
equivalent zero mark function via parameter P879 Bit 13.  

 

  Note 
You cannot have "measuring" and "equivalent zero mark" active on a drive at the same 
time, because you may only select the functions on input I0.x. If you need both functions 
on a drive, you must switch the function. The section on "Expert functions" describes how 
you can write (switch) parameters in the drive from the user program. 

 
Figure 4-52 Digital inputs 
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● Not all of the parameters for the SIMODRIVE 611U can be specified by means of 
technology screen forms. To enter parameters directly (e.g. parameter P879), open the 
expert list. Here you can select and modify the relevant parameters. 
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Parameters to be entered directly: 
– P879 bit 13: 

Enable the Equivalent zero mark function. This setting is necessary if you use the 
Homing only homing cam" function. In addition, you must select the equivalent zero 
mark function for input I0.x.  

– P880: 
This specifies the scaling of the PROFIBUS speed value. For the maximum speed, a 
setpoint NSET = 4000 0000 hex is transferred to the drive via the PROFIBUS. The 
P880 parameter is used to inform the SIMODRIVE 611U which speed should be set 
when NSET = 4000 0000 hex. This speed must agree with the "maximum motor 
speed" value specified when the axis is created (Window axis configuration - Axis 1 - 
Encoder number). 

● This concludes the drive configuration. If there are no errors, the green 5 VDC LED and 
the yellow STOP LED are now illuminated on the technology CPU (the operating mode 
switch is in the STOP position). The LED on the PROFIBUS module of the SIMODRIVE 
611U is illuminated green. 

The standard commissioning is now completed. 
If you would like to use special functions of the SIMODRIVE 611U from the user program, 
you should also read the Expert functions section. 

See also 
Important parameters on the SIMODRIVE 611U (Page 74) 
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Expert functions 5
5.1 Introduction 

Contents 
This section explains functions that can be used in conjunction with the SIMODRIVE 611U 
and that go beyond the standard connection. These functions primarily involve evaluating or 
influencing data of the SIMODRIVE 611U in the user program.  
Furthermore, you can make certain operational settings on the SIMODRIVE 611U, such as 
control of just one axis with the double axis module, or utilize functions, such as using 
unassigned analog inputs and outputs, in the user program.  

 

 Note 
This section assumes that you are well-acquainted with the SIMODRIVE 611U. The function 
options are only briefly presented. For more information, refer to the Description of Functions 
for SIMODRIVE 611 Universal "Closed-Loop Control Components for Closed-Loop Speed 
Control and Positioning". 
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5.2 Important parameters on the SIMODRIVE 611U 

Description 
This table lists the parameters of the SIMODRIVE 611U that are evaluated in connection 
with the technology CPU or must be taken into account during adaptation to the technology 
CPU.  
Some of the listed parameters are supplied during the standard commissioning (see the 
"Commissioning" section). Some of the parameters can also be entered using the 
configuration screen forms.  
Drive parameters can also be written via the user program. For further information, refer to 
the "S7 Technology" Manual, "Technology functions - basic functions, FB 454 
MC_WriteRecord - write data record" section. 

Table 5-1 Important parameters and their meaning 

Parameter Meaning 
P 660 Function selection for input I0.x 

• 79 Zero mark substitute 
If the encoder zero mark cannot be evaluated when homing, then a signal supplied from a mounted 
sensor can be fed via this input as "zero mark equivalent". 

• 80 Measuring input 
maximum number of measuring inputs with SIMODRIVE 611U = 1; caution: Measuring can only be 
performed via this input (I0.x). 

P 700 Operating mode 
For 2-axis module only: Axis B can be deselected. 

P 875 Expected optional module type 
PROFIBUS communication for Drive B can be deactivated here, if only one axis is operated on the 2-axis 
module. 

P 879 Sign-of-life monitoring in the drive is active  
Bits 0, 1, 2: permitted sign-of-life error 
Bit 8: deselect the sign-of-life monitoring 
Bit 12: activate the direct measuring system 
Bit 13: use incremental measuring system with zero mark equivalent 

P 880 Specifies scaling of the speed for motion with PROFIBUS DP. Here you specify the maximum speed of 
the motor. You must also enter this speed in S7T Config when the Axis technology object is created. 

P 881 Specifies scaling of torque reduction for motion with PROFIBUS DP. 
P 915 PROFIBUS process data setpoint assignment  
P 916 PROFIBUS process data actual value assignment 
P 918 DP slave address as specified in the STEP 7 project with HW Config. 
P 922 Message frame type as specified in the Axis technology object. Also refer to the "Adapting message 

frames individually" item. 
P 1001 Speed ctrl clock cyc 

Input value 4 → 4 x 31.25 µs = 125 µs for sin/cos 1 Vpp drives 
Input value 16 → 16 x 31.25 µs = 500 µs for resolver drives 

P 1042 
P 1044 

Fine resolution absolute track G1_XIST1 → fixed input value: 11 
Fine resolution absolute track G2_XIST1 → fixed input value: 11 

P 1043 
P 1045 

Fine resolution absolute track G1_XIST2 → fixed input value: 9 
Fine resolution absolute track G2_XIST2 → fixed input value: 9 

P 1795 Firmware for option module 
P 1799 Firmware for closed-loop controller 
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5.3 PROFIBUS message frame 

Message frame structure 
Depending on the application, it is possible that certain drive functions must be used, e.g. the 
torque reduction. Using the message frame structure, you can see which data and thus 
which functions are available by default for the respective message frame. 

 
Figure 5-1 Message frame structure 



Expert functions  
5.4 Adapting message frames individually 

 Connecting the SIMODRIVE 611U to the Technology CPU 
76 Product Information, 03/2008, A5E00272066-05 

5.4 Adapting message frames individually 

Introduction 
The drive may require additional functions, beyond the predefined message frames, for an 
application. It is possible to expand the predefined message frame for this purpose. These 
additional values can be used in the user program by the 
MC_ReadPeriphery/MC_WritePeriphery technology functions or by other technology objects 
(output cams). The "axis" technology object does not access this data.  

 

 Note 
The described procedure concerns only the peripherals on the DP(DRIVE). 

 

Proceure for expanding the message frame 
● Find the message frame type required for your axis type from the table above. 
● Then in HW Config, append the desired number of additional words after the last word of 

the selected message frame. 
Supplementary conditions for the address assignment for the message frame expansion:  

 
Address in the DP(DRIVE) 
peripheral image 

Use 

0 - 63 The data can only be processed using the MC_ReadPeriphery and 
MC_WritePeriphery technology functions, e.g. to use the analog 
output on the drive.  
Technology objects cannot access this data. 

>= 64 The data can be used by other technology objects, e.g. to use the 
integrated outputs of the drive as output cam outputs.  
The data cannot be used in the user program.  

(Remark: As the message frame structure no longer corresponds to the selected message frame 
type, another message frame or "no message frame" is displayed.) 

● When creating the technology object in S7T Config, you must specify the originally 
selected message frame type. The technology object evaluates only the number of words 
corresponding to the specified message frame type. The additional data can be 
processed in the user program using the MC_ReadPeriphery and MC_WritePeriphery 
technology functions or by other technology functions. 

● In the SIMODRIVE 611U, you must generate the desired message frame structure 
manually using the signal numbers. To do this, set parameter P922 to 0. You can use 
parameter P915 Index 1 to 16 and parameter P916 Index 1 to 16 to enter the signal 
numbers corresponding to the message frame. 

● A maximum of 16 process data words can be read or written. 
 

 Note 
The data area for message frame extensions or for the data exchange with DPV0 slaves on 
the DP(DRIVE) is limited in the technology CPU to 64 bytes (I/O address 0 - 63). The data 
made available using this address area can be read or written in the user program using the 
MC_ReadPeriphery or MC_WritePeriphery technology functions, respectively. 
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5.5 Example: Expanding the process data area 

Introduction 
The signals of the process data area are updated in the PROFIBUS cycle clock. The 
evaluation takes place on the SIMODRIVE 611U in the speed control cycle clock (standard 
125 µs). The reading and writing of the signals are performed asynchronously using the 
technology functions.  

Task specification 
● Based on the desired axis functionality, message frame 102 is to be used to connect the 

SIMODRIVE 611U. 
● Both of the analog inputs of the SIMODRIVE 611U are to be read in the user program. 
● An analog value of 0 to 10 V is to be output via the two analog outputs. 
● The actual torque value of the drive is to be evaluated in the user program. 

 

  Note 
The analog channels on the SIMODRIVE 611U are not required for the PROFIBUS 
connection, and the user can make use of these as desired.  

In order to utilize the function, message frame 102 must be expanded as follows: 

 
Figure 5-2 Message frame 102 

 
Message frame 102 

Additional functions 

Not assigned 
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Adaptations for SIMODRIVE 611U with SimoCom U 
Settings differ from those described in the section on "Commissioning" as follows: 
Call up the Analog outputs menu item in the SimoCom U. Parameterize the following 
functions:  
● First output: DAU1 signal from PROFIBUS PPO 
● Second output: DAU2 signal from PROFIBUS PPO 
Then expand the PROFIBUS message frame using the expert list.  
● How to Proceed: 

– P922 = 102 
This results in a standard assignment of the P915 and P916 parameters 
corresponding to message frame 102. 

– P922 = 0 
This setting enables you to freely set up the message frame using the P915 and P916 
parameters. The standard assignment (step 1) is still available, i.e. you only have to 
enter the additional signals. 
P915:1 to P915:6 → standard assignment in accordance with message frame 102 
Setpoints 
P915:7 = 50103 → analog output 1 (DAU1) 
P915:8 = 50105 → analog output 2 (DAU2) 
P916:1 to P916:10 → standard assignment in accordance with message frame 102 
Actual values 
P916:11 = 50104 → analog input 1 (ADU1) 
P916:12 = 50106 → analog output 2 (ADU2) 
P916:13 = 50114 → smoothed torque setpoint (Mset) 



 Expert functions 
 5.5 Example: Expanding the process data area 

Connecting the SIMODRIVE 611U to the Technology CPU 
Product Information, 03/2008, A5E00272066-05 79 

Settings in S7T Config 
Settings differ from those described in the section on "Commissioning" as follows: 
Configuring the hardware 
● Message frame selection: 

Select message frame 102 
● Configure a new setpoint slot using the following data: 

Drive type: Setpoint 
PROFIBUS partner type: Output 
Address: 0 
Length: 2 
(Two additional words, DAU1 and DAU2) 

● Configure a new actual value slot using the following data: 
Drive type: Actual value 
PROFIBUS partner type: Input 
Address: 0 
Length: 3 
(Three additional words, ADU1, ADU2 and Mset) 

Message frame configuration overview: 

 
 

Ensure for the configuration that the expansion in the sequence of the process data lies after 
the message frame data (this can be seen in the Drive and Address column).  

 

 Note 
Due to this change, the message frame structure no longer corresponds to message frame 
102. For this reason, "No message frame" or another message frame type is displayed after 
the change. You can ignore this change. You address the drive using the originally intended 
message frame type (102 in our example).  

 
Creating the TO axis 
● Axis configuration: 

The drives created in the HW configuration can be selected here. Select the desired 
drive.  

● Message frame: 
Specify message frame type 102. The part of the message frame relevant for the Axis 
technology object, corresponds to message frame 102. 
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Access in the user program 
The MC_ReadPeriphery and MC_WritePeriphery technology functions are used to process 
in the user program the data made available in the message frame expansion. The 
technology functions are processed asynchronously. 
Call the MC_ReadPeriphery technology function to read the values of the analog inputs and 
the torque actual value: 

 
CALL "MC_ReadPeriphery" , "IDB_FB450" 
 Enable :=M10.0 

InputOutput :=FALSE 
ByteAddress :=0 
Data :=P#DB100.DBX 0.0 WORD 3 
DataValid :=M10.1 
Busy :=M10.2 
Error :=M10.3 
ErrorID :=MW12 

 
When the technology function (Enable = TRUE input) is started, starting at address 0, three 
words will be read from the DP(DRIVE) peripheral image and saved at the address specified 
in the ANY pointer.  
Call the MC_WritePeriphery technology function to write the setpoints for the two analog 
outputs: 

 
CALL "MC_WritePeriphery" , "IDB_FB451" 
 Execute :=M20.0 

ByteAddress :=0 
Data :=P#DB100.DBX 0.0 WORD 2 
DoneFlag := 
Done :=M20.1 
Busy :=M20.2 
Error :=M20.3 
ErrorID :=MW22 

 
When the technology function (Execute FALSE -> TRUE input) is started, the two words 
specified in the ANY pointer will be written in the DP(DRIVE) peripheral image starting at 
address 0 and thus sent to the drive.  
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5.6 Disable the sign-of-life monitoring 

Introduction 
The PROFIBUS connection between the technology CPU and the SIMODRIVE 611U is 
monitored using the sign-of-life. As a general principle, sign-of-life monitoring must be active 
during operation. Sign-of-life monitoring is automatically selected when the axis is created. In 
case of problems (for example, alarm 832 on the SIMODRIVE 611U), the sign-of-life 
monitoring can be deactivated temporarily for diagnostic purposes. 

Technology CPU 
The parameters for the sign-of-life monitoring can be selected or deselected on the TOaxis 
via Expert list > Configuration data ....lifeSignCheck. 

SIMODRIVE 611U 
The sign-of-life monitoring can be deactivated using the P879 Bit 8 parameter. 

5.7 Activate the second encoder 

Introduction 
In the technology CPU, you can use the second encoder input on the SIMODRIVE 611U 
double-axis module for the actual value acquisition. Axis B of the SIMODRIVE 611U cannot 
then be used to control a motor. 

Technology CPU 
A PROFIBUS message frame must be used for the second encoder (refer to the "Message 
frame type" decision table in the "Settings Table" section). 

SIMODRIVE 611U 
When axis A is created: Create the second encoder by specifying Which direct measuring 
system are you using? > Enter data. Then enter the required encoder type. Depending on 
the configuration of the SIMODRIVE 611U, it is necessary to adapt the following parameters: 
Parameter P879 Bit 12 = 1 -> Enable direct measuring system (Axis A) 
Parameter P922 -> PROFIBUS message frame type (Axis A) 
Parameter P700 = 0 -> Deselect Axis B (Axis B) 
Parameter P875 = 0 -> Expected option module type (Axis B) 
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5.8 Activating a brake 

5.8.1 Vertical axis application case 

Introduction 
When a braking sequential control is used in conjunction with a vertical axis, the axis should 
remain at its position when the system is shutdown or in a fault situation. 
The axis enable can be reset by an alarm in the technology CPU or by disabling the 
MC_Power function (Enable input = false). 
The extended brake control should allow the ON/OFF1, OFF2, OFF3 and enable operation 
(enable pulse) bits to be switched off sequentially. This ensures that the brake is already 
closed when the pulse enable for the axis is disabled, thus preventing the axis from twisting / 
sagging. 

5.8.2 Universally activating the braking control in the SIMODRIVE 611 

Introduction 
To universally activate the braking control of the SIMODRIVE 611 you must set the  
P0850 to 1. 

Procedure 
Activating the braking control 
The following parameters are available for the "motor holding brake" function:  

 
Parameter Meaning 
P0850 Activates the braking control 
P0851 Brake opening time 
P0852 Speed - close holding brake (SRM, ARM), motor speed - close holding brake (SLM) 
P0853 Brake delay time 
P0854 Controller disabling time 
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Allocating the brake activation function to the digital output 
In the expert list of the universal SIMODRIVE 611, each digital output has its own parameter. 
Enter function value 35 in the parameter to which the digital output used in your application 
is assigned. You can also invert the digital output via the bit mask in parameter P0699. 

 
P0680 Alarm function - output terminal O0.x 
P0681 Alarm function - output terminal O1.x 
P0682 Alarm function - output terminal O2.x 
P0683 Alarm function - output terminal O3.x 
P0684 Alarm function - output terminal O4 
P0685 Alarm function - output terminal O5 
P0686 Alarm function - output terminal O6 
P0687 Alarm function - output terminal O7 
P0688 Alarm function - output terminal O8 
P0689 Alarm function - output terminal O9 
P0690 Alarm function - output terminal O10 
P0691 Alarm function - output terminal O11 

 
 

P0699 Inverting the output terminal signals 

Example 
Use output O3.A to activate the brake. Enter function value 35 in parameter P683. 

  

24 V

0 V

M
3 ~
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5.8.3 Activating braking sequential control in the axis 

Introduction 
The enable bits ON/OFF1, OFF2, OFF3 and operation enable (pulse enable) of the axis are 
coordinated via the braking control that is integrated in the drive. This means that, when the 
axis is switched off normally or in the event of an axis error, you can make sure that the 
brake is already closed before the pulse enable is cancelled, hence preventing the axis from 
sagging.  
There are two different operating states: 
● Switch axis on / off normally using MC_Power 
● Switch off the axis in the event of axis errors with error response "RELEASE_DISABLE" 

Procedure for configuring switching the axis on / off normally using MC_Power 
You configure an axis to switch on / off normally with braking control using the stop modes 
on the MC_Power block: 

 
Stop mode Name Description 
3 Coast stop (OFF2) The drive coasts to a standstill without power; the brake 

closes immediately 
5 Ramp stop (OFF1) Stops the axis via the ramp function encoder 
6 Fast stop (OFF3) Stops the axis via a fast stop ramp 

You will find further information in the Online Help for the MC_Power block. 
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Procedure for configuring the axis response to axis errors with error response "RELEASE_DISABLE" 
The response of the axis to axis errors with the "RELEASE_DISABLE" error response is set 
by changing the configuration in S7T Config. 
● Switch to the configuration dialog for the axis, and click the "Drive settings ..." button. 

 
 



Expert functions  
5.8 Activating a brake 

 Connecting the SIMODRIVE 611U to the Technology CPU 
86 Product Information, 03/2008, A5E00272066-05 

● Select the required response by the axis to axis errors with an error response 
"RELEASE_DISABLE". 

 

Ramp stop (OFF1): 
Braking takes place at the drive's ramp function encoder ramp. When the speed threshold is 
reached, the holding brake is enabled which disables the pulse enable once the brake 
closing time has elapsed. 
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Coast stop (OFF2): 
In this case the power enable is cancelled immediately, and the drive costs to a standstill. In 
parallel, the mechanical braking control is enabled immediately. This engages the brake, 
which actively brakes the drive. The mechanical stress on the brake depends on the load to 
which it is subjected. 

 Holding brake
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Fast stop (OFF3): 
The drive is braked at the fast stop ramp (emergency stop). When the speed threshold is 
reached, the holding brake is enabled which disables the pulse enable once the brake 
closing time has elapsed. 
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